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PROPRIETARY STATEMENT

This document and subject matter disclosed herein are proprietary items to
which Watkins-Johnson Company retains the exclusive right of
dissemination, reproduction, manufacture and sale.

This document is provided to the individual or using organization for their
use alone in the direct support of the associated equipment unless
permission for further disclosure is expressly granted in writing.

WARRANTY

Seller warrants for a period of one year from the date of shipment. unless a
different period has been agreed upon and incorporated into the Contract.
that the products delivered or services rendered will conform to the
specifications and be free from defects in workmanship and materials.
THE FOREGOING WARRANTIES ARE EXCLUSIVE AND IN LIEU
OF ALL OTHER WARRANTIES OF MERCHANTABILITY, FITNESS
FOR PURPOSE, OR OTHER WARRANTIES OR GUARANTIES OF
ANY KIND OR DESCRIPTION, WHETHER STATUTORY, EXPRESS,
OR IMPLIED. If the goods delivered or services performed fail to
conform to the warranty stated in this clause, Seller will correct the
nonconformity at its expense by such repair, adjustment, modification, or
replacement of the goods or services as Seller deems expedient. THE
FOREGOING REMEDY OF BUYER FOR ANY FAILURE OF THE
GOODS OR SERVICES TO MEET ANY WARRANTY IS EXCLUSIVE.
BUYER EXPRESSLY AGREES THAT THE LIABILITY OF SELLER
UNDER ANY WARRANTY SHALL NOT INCLUDE DAMAGE TO
OUR LOSS OF PROPERTY OTHER THAN THE GOODS COVERED
BY THE CONTRACT; LOSS OF PROFITS OR REVENUE;
INCREASED COSTS OF ANY KIND; CLAIMS OF CUSTOMERS OF
BUYER; OR ANY INDIRECT, SPECIAL, INCIDENTAL, OR
CONSEQUENTIAL DAMAGES. As to goods or components where the
customer has funded the repair, Seller will warrant as limited above, the
repaired portion of the unit for three months from the date of reshipment.
EQUIPMENT OR PARTS DESCRIBED AS BEING MANUFACTURED
BY OTHERS ARE SOLD BY SELLER AS IS and Buyer must look to the
respective manufacturer for any and all claims with regard to said
equipment or parts.
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SECTION 1

GENERAL DESCRIPTION

1.1 INTRODUCTION

1.2 GENERAL DESCRIPTION

This section provides a general description of the WJ-RCS Receiver
Control Software capabilities and applications. Refer to Figure 1-1. The
use of the WJ-RCS Control Software package presumes the operator has a
working knowledge of the Microsoft® Windows environment and is
familiar with the options and capabilities that are available on the PC

screen.

Playback

FreqListEditor Read Me Files Info

97-0154

Figure 1-1. WJ-RCS Program Icons

RCS is a collection of software applications for many WJ receivers that
run under Microsoft® Windows. These applications allow the receiver
user to control, monitor and collect audio data. Using RCS, the receiver
user can perform the following tasks:

Perform real-time control of either a single receiver or multiple
receivers.

Provide a Signal Monitor Pan display when using a WJ-9168 Signal
Monitor.

Display RF spectral data from receiver sweep or step modes.
Collect intercepted audio data on a PC as WAVe files.
Play back and analyze collected audio data.

Generate signal frequency lists.

GENERAL DESCRIPTION
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1.3 RCS APPLICATIONS DESCRIPTION

1.3.1 CONTROL RX’S

1.3.2 AUDIO PLAYBACK

RCS provides the following window applications to program and execute
the missions as well as permit real time control of the receiver.

° Control Rx’s
° Audio Playback

e Frequency List Editor

This application allows the user to have real-time control of up to twelve
receivers. The four modes of operation provide the operator with a choice
of Manual, Spectral, Priority, or Mnemonics operations. The Manual
mode gives the operator direct control of the receiver through use of an on-
screen receiver control panel. The Spectral mode allows a receiver to
sweep and provide an RF Pan display for up to ten sweep sectors. The
Priority mode steps the receiver through up to 100 predefined discrete
frequencies. The Mnemonics mode provides control of the receiver via
use of remote control commands. The Control Rx’s application allows the
user to specify other pertinent receiver parameters for each receiver, such
as bandwidth, increment frequency, and a threshold value. The user may
also assign up to four receivers to provide inputs to two signal monitors
which provide outputs for instantaneous on-line analysis on the PC screen.
Receiver fine tuning can be performed via mouse control of the RF on
Signal Monitor Pan display. Signal lists generated during on-line
operation may be used to generate lockout frequencies or change a
receiver’s operating parameters. These signal lists may also provide data
for building off-line missions associated with the Mission Builder
Application.

The Audio Playback application allows the user to play back digital audio
files created by the Spectral Acquisition and Priority Acquisition missions.
This application graphically displays the digital audio files along with the
time of collection, frequency and signal strength. Audio is available for
playback by moving the pointer to the graphical file display and clicking
on the mouse. Playback may be by individual audio files, sequentially by
time of collection, or time sequentially by frequency. Individual files may
be marked as identified, unidentified, or signals of interest. These files
may be displayed as video waveforms, or analyzed using commercial
WAVe audio packages.

GENERAL DESCRIPTION
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1.3.3 FREQ LIST EDITOR

The Frequency List Editor application allows the user to create, edit, and
store frequency lists independent of the software controlling the receiver.
These lists can be recalled from memory and used at a future time.

1.4 EQUIPMENT SUPPLIED

The following equipment is required to use the WJ-RCS package:

IBM 486DX33 or better PC with at least 4 MB of RAM and 4 MB
of hard disk space. :

MS Windows 3.1 with MS DOS 5.0 or above. MS Windows 95 is
recommended for multi-receiver control.

At least one or more of the following communications Interface(s):
Serial Communications Port 14,
National Instruments GPIB card and NI-488.2 software, or
National Instruments VXI slot O controller with VISA.

One or more of the following WJ receivers:
WI-860X, WJ-860XA, WJ-8609A Miniceptor Family with
RS-232 interface,

W1JI-8611 VHF/UHF Receiver,

W1J-8629 VXI Digital VHF/UHF Receiver,
W1JI-8634 VXI VHF/UHF Receiver Family,
WJ-8635 HF/VHF/UHF Receiver Family,
W1J-8654 Microceptor Family,

WJ-871XA HF Receiver Family,

W1J-8721 VXI Digital HF Receiver,
WJ-9902 Miniceptor Frame,

WIJ-9903 Miniceptor Frame,

W1J-9904 Microceptor Frame, or

W1J-9908 Miniceptor Frame.

MS Windows compatible WAVe device for audio storage and
playback.

Cable(s) to connect receiver to computer.

GENERAL DESCRIPTION
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FreqList Editor Read Me Files Info

97-0154

Figure 2-1. Program Group Window for WJ-RCS

2.3 EQUIPMENT MALFUNCTION

The RCS software was thoroughly tested prior to shipment. If an apparent
malfunction is encountered after installation:

1.

Verify that the PC has enough free RAM to load and run correctly.
A minimum of 4 MB of RAM is recommended. At least 4 MB of
free hard disk is required.

Run the program installation procedure again. If the malfunction
persists, contact your Watkins-Johnson representative via mail,
telephone, wire or cable at:

Watkins-Johnson Company
Customer Service Department

700 Quince Orchard Road
Gaithersburg, Maryland 20878-1794

Toll Free: 1-(800) 954-3577
TELEX: 89-8402

TWX: 710-828-0546
TELEFAX: (301) 948-5666
EASYLINK: 62928185

INSTALLATION
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SECTION 2 INSTALLATION]|

2.1 INTRODUCTION

This section provides information about installing the RCS software.

2.2 INSTALLING THE RCS SOFTWARE

Before executing the RCS software, it must be properly installed on the
operator’s controlling computer. An installation program, SETUP.EXE, is
provided on the RCS disk. This program ensures proper installation. of all
the RCS software to the operator’s disk and creates configuration files
that store configuration information for use by the RCS software.

NOTE: The following procedure is for installing the RCS software
from DRIVE A to DRIVE C. If using any other drives or
configurations, consult your computer’s user manual.

To install the RCS software:

1. Start Windows.

2. Close all other applications.

3. Insert WJ-RCS SETUP disk into DRIVE A.

4. éelf.:ct File from the Program Manager Menu Bar.

5. Select Run... from the File Menu.

6. At the Command Line, enter A: SETUP.EXE.

7 Select OK.

8. At the completion of the RCS software installation procedure, a
WI-RCS program group appears on the Program Manager Window.

If the software loaded properly, the WJ-RCS program group should
look like Figure 2-1.

INSTALLATION 2-1
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SECTION 3

OPERATION

3.1 INTRODUCTION

3.2 CONTROL RX’S

This section provides instructions on using the RCS software to perform
real-time control of a single or multiple receiver(s), create and listen to
audio playback clips, and generate, edit, or store frequency lists. This
software  operates on a Windows™-capable personal computer.
Successful operation assumes the following:

1% Requirements outlined in paragraph 1.5 have been met.

2 Software installation has been accomplished as outlined in
; paragraph 2.2.

3. Hardware configuration is completed.

4. Computer is running and the window shown in Figure 2-1 is

present on the computer screen.

5t The operator is familiar with the Windows™ screen presentation
and capable of manipulating and understanding the options
available.

The Control Rx’s application, part of the WIJ-RCS Receiver Control
Software, permits real-time control of up to twelve receivers and up to
two WIJ-9168 Signal Monitors. Multi-receiver configurations require
Windows 95 or Windows NT. During its operation, the application can
independently or simultaneously provide RF Pan displays and Signal
Monitor Pan displays. The application also allows newly acquired signals
to be logged onto a Signal List ASCII data file. This file can then be used
to update a selected receiver’s priority search list to further enhance signal
acquisition or to provide a frequency for a lockout function. This signal
list also provides data useable in creating missions for Mission Collection
applications. Double-clicking on the Control Rx’s icon, with the receivers
turned off, produces the window shown in Figure 3-1. Check to see that
the receivers are properly connected and power is applied. Click on the
“Retry” button to get to the Receiver Control Panel screen. Double-
clicking on the Control Rx’s icon with the system receivers on, produces
the window in Figure 3-2. The initial use of the software requires
entering the system hardware configuration prior to use.

OPERATION
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WJ-RCS... Hardware Setup Error!

WARNING MESSAGE:

Unable to communicate with receivers. Please
check cables and click Retry, or click Config
to verify System Hardware Configuration, or
Abort to terminate program.

= WJ-RCS. RECEIVER CONTROL SOFTWARE
File Config List Help

Figure 3-2. WJ-RCS Receiver Control Panel Window

The WJ-RCS Receiver Control Software has on-line help and help files to
identify and provide operational directions for each area of the screen. By
moving the pointer over the screen, pertinent information appears on the
on-line help window at the bottom of the screen. To access help files,
place the pointer over the desired area and press the F1 function key or
click “Help” in the main menu bar.

OPERATION
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3.2.1 CONFIGURING THE SYSTEM HARDWARE

There are two ways to enter the System Hardware Configuration Panel of
the Control Rx’s application. If accessing the application with the receiver
powered down, clicking on the Control Rx’s icon produces the screen
shown in Figure 3-1. Move the pointer to the “Config” button and click
the mouse. If the receiver has power applied, clicking on the Control Rx’s
icon produces the screen shown in Figure 3-2. Click on “Config” in the
main menu bar, then “System”. Either method produces the System
Hardware Configuration Panel shown in Figure 3-3. In either case, if this
is the initial use of the WJ-RCS Receiver Control Software, the system
must be configured prior to its operation. The following steps will assist in
system configuration:

1 Choose a unique, identifying name for each receiver.

2 Select the interface and interface configuration from pull-down
menus.

3. Select unique addressing when using a GPIB interface.

4. If using WJ-9168 Signal Monitors, assign receivers to a monitor and
input port via pull-down menu selections.

5. Select Signal Monitor interface and configuration from pull-down
menus.

6. Select an appropriate Switched Audio Output (SAO) and headphone
output.

7. Save the system configuration as a .CFG file for future use.

[Receiver Configuration

Name [intestace Serial [Serial |Serial [VXI |GPIB|GPIB[SigMon [SigMon
Baud |Frame |Device|Slot |Prim |Sec [Numbe|Input
Rate Addr |Addt
01 ] \i; Serial-Single COM 1 1115200 : : L300 1 1
R28654  SeriabMukiFrame COM 2 138400 :27 i1 1 2
03 |RIBE07A _iSeriakMultFrame COM 2 138400 {22 i1
04 : i H i
05 |R49304 GPIB : 11 12 i1 Shared
06 _|R59304 GPIB i ; 2 12 i1 Shared
07 ! ; I i
08 |R68711A _GPIB ; i2
03 i ] i
10 |R78623 VX 2
11 |R88721 WX i i 3
12 i & H H
[ Signal Monitor Configuration, WJ-8168— | SAOC Phones
: . ™ Auo K Auo
" Serial [Serial [Serial | [GPIB[GPIB
Baud |Frame |Dévice| |Prim [Sec || [ Men Reset
= Rate Addr |Addr § | |B%: Record | | option
> i 7
02_|Seria-MutiFrame COM 2 138400 i23 1 |_3k—_l I_X—]

Receiver Configuration window ...

970175

Figure 3-3. WJ-RCS Configuration Panel

OPERATION
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Configuring The Receivers

The critical part of setting up the System Hardware Configuration Panel is
to determine the configuration of the hardware, itself. Receivers and/or
Signal Monitors have to be properly configured according to the desired
setup and in accordance with instructions available in each equipment
type's technical manual. To configure the receivers, fill in the Name,
Interface Type, Baud Rate, Frame Address, Device Address, and the
associated Signal Monitor Number and Input Port. The Frame and Device
Addresses are only required if the receiver is configured to operate in a
Multi-Drop interface mode. These addresses are dependent on the type of
receiver being used and can be obtained from the receiver’s technical
manual. In the Single Drop mode, however, the Frame and Device
Address fields should be. left blank. This also applies to the Signal
Monitor Number and Input Port fields. These fields should be left blank if
there is no signal monitor available in the system. The following
paragraphs pertain to configuring the receivers.

Device Name

Using the computer mouse, select the first box under “Name” by double-
clicking in that space. A pop-up box appears on the screen for entering a
unique, identifying name for receiver R.01. After entering the device
name, click “OK” to complete entering the receiver’s name.

Interface type

Double-click on the first box under the “Interface” column. A pop-up
menu appears that allows selection of the interface type. Click on the
down arrow to bring the selection list on screen. Highlight the type of
interface that exists for the system. Click on “OK” to complete entering
the interface type.

Baud Rate

Double-click on the first box under the “Serial Baud Rate” column. A
pop-up window appears that allows selection of the baud rate. Click on the
down arrow to see the baud rate selection list. Highlight the baud rate
compatible with the PC and the receiver type being used. Click on the
“OK?” to complete entering the selected baud rate.

OPERATION
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Frame/Device Address

VXI Slot

GPIB Primary Address

There is no need to select a Frame Address or Device Address if the
receiver is in Single Drop mode. However, if the receiver is in Multi-Drop
mode, these address fields must be entered with the correct information.
These address numbers are device specific and are dependent on the
internal DIP switch settings associated with a receiver. Refer to the
receiver technical manual for details. After researching the required
information, double-click on the appropriate box in each column and insert
the correct numbers. Click on the “OK” button after each entry to enter
the correct information and return to the main configuration screen.

Double-click on the first box under the “VXI Slot” column. A pop-up
window appears that allows the VXI slot number to be entered. The slot
number used must match the slot number in which the receiver is installed.
This field only applies if the interface selected is VXI.

The GPIB Primary Address field is only active if the selected interface is
GPIB. Double-click on the proper box in the “GPIB Prim Addr” column.
A pop-up window appears. Enter the appropriate address of the frame.
See the associated frame manual for details on setting the GPIB address.
In devices like the WJ-990X, which hold multiple receivers, both the
Primary and Secondary GPIB Addresses must be specified.

GPIB Secondary Address

The GPIB Secondary Address Field is only active if the selected interface
is GPIB. The secondary address refers to a receiver address in a frame,
such as a WJ-990X-type device. Double-click on the proper box in the
“GPIB See Addr” Column. A pop-up window appears. Enter the
appropriate address. For WJ-8711 and WJ-8611 receivers this field should
be left blank.

Signal Monitor
Number/Input Port

If the receiver connects to a signal monitor, the SigMon Number and
SigMon Input Port fields need to be completed with the appropriate data.
These two fields must be left blank if the receiver does not connect to a
signal monitor.

To tie a signal monitor to a receiver, the “SigMon Number” and “SigMon
Input” columns require data entered. The numbers entered in these two
fields are dependent upon the signal monitor’s number being used and the

OPERATION
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physical connections of the receivers to those signal monitor input ports.
Double-click on the box in the “SigMon Number” column that
corresponds to the receiver being configured. A pop-up window appears
on the screen. Click on the down arrow on the right of the pop-up
window. Highlight the signal monitor number that corresponds to the
receiver being configured. Click “OK” to return to the main configuration
screen.

To enter the signal monitor input port number, double-click on the
appropriate box in the “SigMon Input” column. A pop-up window
appears. Click on the down arrow in the right corner. Highlight the signal
monitor input port number that corresponds to the receiver being
configured. The “1 Shared” and *“2 Shared” selections are for use with the
WI-9904/SM where the signal monitor is shared between 6 receivers.

CONFIGURING THE
SIGNAL MONITORS

The signal monitor fields are to be left blank if there is no signal monitor
connected to the system. If there is a signal monitor in the system, the
Interface and Baud Rate need to be entered with the appropriate date. The
Frame and Device Addresses need to be added if the signal monitor is
configured to operate in the Multi-Drop mode.

Interface/Baud Rate

Refer to Figure 3-3. Configuring the signal monitors first requires the
user to select the appropriate interface and baud rate. The “Interface” and
“Baud Rate” columns under the Signal Monitor Configuration, WJ-9168
heading are used for this purpose. These two columns are selected, and
data entered, in exactly the same manner as entering the interface and baud
rate for the receiver configuration.

Frame/Device Numbers

Configuring the signal monitors for multi-drop is accomplished in the
same manner as for multi-drop receivers. Two additional parameters,
“Serial Frame” and “Serial Device” are required. These two addresses are
device dependent numbers. Consult the WJ-9168 technical manual for the
specific Frame and Device addresses. These two numbers are entered in
exactly the same manner as for the receiver configuration.
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Primary/Secondary Address

Configuring Switched
Audio Output (SAO) and

The Primary/Secondary GPIB address fields are used when the WJ-9168 is
connected through a GPIB device like the WJ-9904 or WJ-8611. See the
associated frame manual for details on configuring these selections. These
addresses are entered in exactly the same manner as for the receiver
configuration.

Headphones

Configuring Switched

Audio Output

Configuring the Headphones

The Switched Audio Output (SAO) has three modes of operation,
automatic, . manual, and off. If neither of the SAO selections is chosen,
the SAOs of the system receivers are turned off. The following outlines
the operation of the two remaining modes.

The SAO “Auto” mode turns on the SAO of the receiver whose control
panel is currently the active control panel and turns off all the others.
Click on the word “Auto” to turn on this function. On the main Receiver
Control Panel screen, there will be a receiver control window for each
receiver configured within the system. As with other Windows operations,
only one window is active at a time. To turn this function off, either click
on “Man” or “Auto” again.

The SAO “Man” mode places an additional menu item on the Receiver
Control Panel screen main menu bar. Click on the word “Man” to turn this
function on. The additional menu selection is named “SAQ”. Clicking on
this menu item produces a drop-down menu that lists the SAO On/Off
option. To turn this function off, click on the word “Auto” or “Man”
again.

The “Phones” selection consists of “Auto” or manual. The use of this
function is dependent upon the receivers having a volume control.
Receivers, such as the WJ-8607 and WJ-8607A do not have volume
control commands. The following outlines the operation of these two
modes.

The “Auto” mode is toggled off and on by clicking on the word Auto. An
“X” appears in the box when it is selected. On the Receiver Control Panel
screen, there is a receiver control window for each receiver configured
within the system. Refer to Figure 3-4 for an example of control of two
receivers. When in “Auto”, the active receiver, last selected by the mouse,
provides the headphone output and the others are shut off. Even though
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the remaining receiver control windows may display a volume level, those
outputs are turned off. Selecting one of the other receivers by choosing its
control panel, turns on its volume, to the previously set level, and turns off
the volume of the formerly active receiver.

Click on the “OK” button to accept the new System Hardware
Configuration setup. Upon exiting this configuration setup, the WJ-RCS
application produces a Receiver Control Panel screen similar to
Figure 3-4. The screen displays one receiver control panel window for
each receiver defined in the configuration setup. Size the screen for
optimum viewing.

WJ-RCS, RECEIVER CONTROL SOFTWARE

Config List Help

Operation

Pan

RECEIVER CONTROL PANEL
Report Lockout Sighion Window

iR.01, UHFpEE S || R.02, UHFME S

Revr's ID: WJ-8607-

Revr's ID: WJ-8607-

96-0453

Figure 3-4. Receiver Control Panel
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3.2.2 OPERATING THE SYSTEM

Refer to Figure 3-4. Once the operator enters the Receiver Control Panel
window, a variety of options are available for setting receiver parameters
and operating modes. The WJ-RCS application automatically queries the
receivers as to their previous mode of operations. The Receiver Control
Panels for the individual receivers depict the operating modes as last set.
The operator has three methods to begin operations. The operator may
choose to operate using the current receiver settings and operating mode,
select a receiver and change its operation, or download a previously stored
file containing receiver operation settings.

Selecting A File

To choose a previously saved operations file, click on “File” in the
selected Receiver Control Panel menu bar, and then on “Open Operation”
from the resulting pulldown menu. Select and open the appropriate file for
execution. This automatically loads the data into the receiver and
commences operation of the selected receiver using the new parameters.

Receiver Control

To gain control of a receiver, click on any part of the specific receiver
control panel with the mouse. Subsequent menu bar operations are then
associated with the selected receiver.

Selecting The
Operating Mode

The user has four operating modes from which to choose: Manual,
Spectral, Priority, and Mnemonic. Each receiver may be configured to
operate in any of the modes. To enter or change the operating mode, click
on “Operation” in the menu bar and then select the mode of operation.

3.2.3 OPERATING IN MANUAL MODE

Operating Procedures

To enter the Manual mode of operation from the Receiver Control Panel
screen, click on “Operation” in the menu bar, then “Manual” from the
associated pull-down menu. During manual mode of operation, signals
may be added to a signal list or to a lockout list.

The Receiver Control Panel provides the operator the means to control the
receiver in the manual mode. See Figure 3-4. This screen supports the
standard receiver control parameters. To see the additional receiver
parameters, click on the “More” button at the bottom of the receiver panel.
See Figure 3-5. Pressing the "Done" button at the bottom of the expanded
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panel returns the panel to its abridged presentation. For each receiver
assigned during the system hardware configuration process, an individual
receiver control panel appears on the screen. If the receiver has a volume
control, a volume scroll bar appears on the panel.

ADD SIGNAL

LOCKOUT

MANUAL

[-104 aPm <
FREQ i} i
=

0023.9207

Signal strength and Tuning indicator, bright blue

96-0454

Figure 3-5. Individual Receiver Control Panel

Receiver Controls

The following controls and functions are available for operating the
receiver. An on-line help window is also available at the bottom of the
control panel. As the cursor moves from function to function on the
receiver control panel, identification and parameters of that function
appear in this window.

Lockout Button. The Lockout button to the right of the word
“FREQ” adds the current receiver’s tuned frequency and bandwidth
to the receiver LockoutList. This signal is excluded from the

* Spectral search operation.

Add Signal Button. This button is located to the right the Lockout
button. It adds the current receiver’s tuned frequency, bandwidth,
detection mode, and COR value to the Signal List. This data is
stored in the Signal List in an ASCII data format. It can be used to
create a priority list or lockout data for a selected receiver.

3-10
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Change receiver frequency. To change the entire receiver
frequency, move the cursor to the frequency readout box and click
the mouse. This action highlights the readout. Use the keyboard to
enter the new frequency in MHz. It is not necessary to enter leading
or trailing zeros. For instance, to enter 2.5 MHz, type “2.5” and
press Enter on the keyboard. An alternate method is to use the
frequency scroll bar located below the frequency readout. The
frequency resolution, tied to the frequency scroll bar, is available
from the boxes above the frequency field.

Detection mode. Clicking on the down arrow in the “DET” box
provides a list of available detection modes for the associated
receiver. Choose the mode by clicking on the desired choice.

IF Bandwidth. Clicking on the down arrow in the “IFBW” box
provides a list of available bandwidths for the associated receiver.
Choose the bandwidth by clicking on the desired choice.

Carrier Operated Relay (COR) threshold. COR is a value that a
signal must exceed before activating the audio output. It is a
measure in decibels above the theoretical noise floor for the selected
IF bandwidth. If “Infinite” is selected, the receiver audio is
effectively shut off. Use the left-right arrows to change the COR
value. An alternate method is to click on the COR readout box.
This highlights the current value. Use the keyboard to enter the new
value and press the “enter” key. To change the COR value to
“Infinity” quickly, click on the word “COR”.

Attenuation. Set receiver attenuation by using the left-right arrows
next to the “ATN” readout :

AFC/AGC. Select these two options by clicking on the appropriate
control button. Clicking on the buttons toggles the function
between On and Off.

Video Bandwidth. Clicking on the down arrow in the “VBW” box
provides a list of the available video bandwidths for the associated
receiver. Choose an appropriate bandwidth by clicking on the
choice or click on “Auto”. The "Auto" choice automatically selects
a video bandwidth equal to half of the selected IF bandwidth.

IF Oscillator. Click on the “IFO” readout box to change this value.
Use the keyboard to enter the appropriate value. The *“IFO”
frequency is only valid if the IFT detection mode is selected.

OPERATION
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° BFO. Use the left-right arrows to change the Beat Frequency
Oscillator (BFO) frequency or click on the readout box and enter
the value via the keyboard. Press Enter to validate the entry.

° Pre Dwell Timer. Determines how long a receiver waits at a
frequency during a scan before retuning. Type in the desired value
or use the left-right arrows to change the value. The value is in 4
msec increments. Entering a number outside the 4 msec increment
causes the readout to choose the nearest correct number, i.e.,
entering 995 causes the readout to be 996. Type in a *“-1” for
infinity. Refer to the associated receiver manual for a detailed
explanation of this timer.

o Signal Dwell Timer. Determines how long a receiver sits on a
frequency during a scan before retuning. Type in the desired value
or use the left-right arrows to change the value. The value is in one
second increments and is receiver dependent. Type in a “-1” for
infinity. Refer to the associated receiver manual for a detailed
explanation of this timer.

° Loss Dwell Timer. Determines how long a receiver sits at a
frequency during a scan after losing a signal before retuning. Type
in the desired value or use the left-right arrows to change the value.
The value is in one second increments and is receiver dependent.
Type in a “-1” for infinity. Refer to the associated receiver manual
for a detailed explanation of this timer.

e Bypass. Clicking on this Control Button to “ByPass ON” causes the
Preselector to be bypassed. Clicking on the button again, toggles
the selection to “ByPass Off”.

° Clicking on the button labeled “Done” closes the right half of the
 receiver control panel.

Remember, the receiver control panel appearance is dependent upon the
type of receiver being used. The appearance of the on-screen receiver
control panel may vary. The techniques on changing the parameters
remain the same.

Signal List

The Signal List is used to build a data base for ease of system operations.
Once parameters are entered, they may be used to build collection mission
files, create on-line receiver tasking, or be stored for future use. Once
parameters are on this list, they may be edited, deleted, stored, or
transferred to an active receiver for on-line analysis.

3-12
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Config List Help

WJ-RCS, RECEIVER CONTROL SOFTWARE

Refer to Figure 3-6. To obtain the Signal List, click on “List” in the WJ-
RCS menu bar, and then on “Signal” in the pull-down menu. A Signal
List Panel appears on the screen. To add the current receiver parameters
to this list, click on the Add Signal button on the active receiver control
panel. The parameters are entered on the list and automatically
highlighted."

ijile Operation Pan

Window

= " RECEIVER CONTROL PANEL
Report Lockout

B E[siGNAL LIST PANEL - T EE R
File Tools
Freq IFBw Cor Det Typ

SigMon

= R0 VHIWE E
[ MANUAL ]
-095 dBm <
FREQ X =
0106.7214

Lockout current tuned

Sianal# 0001

96-0455

Figure 3-6. Signal List Panel

The operator has several choices in using the Signal List. Using options
under the “File” pull-down menu, the operator may open a new file, open
and existing Signal List file, import a file from other collection missions,
rename a file using SaveAs, or close the Signal List file.

The operator has the option of manipulating the data on the Signal List.
Those functions are found on a pull-down menu, under “Tools”, or
accessed through the buttons on the bottom of the screen. The functions
include Add, Edit, Del, and Transfer. The following paragraphs outline
their operations.

Signal List Add Function

OPERATION
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Enter the “Add” function by using the “Tools” pull-down menu or by
clicking on the “Add” button. See Figure 3-7.

SIGNAL LIST PANEL - [tr[EE 2

Freq IFBw Cor Det Typ

Add Panel...
00.030 |20

[Am Ig Osoi Oids ® ?s
T

EDIT or ENTER new comments

96-0456

Figure 3-7. Signal List Panel, Add Function

The Add Panel allows the user to enter the frequency, IFBW, COR value,
detection mode, and type of signal. The bottom field is for entering
comments. The meanings for abbreviations for the types of signals are as
follows:

soi - Signal of Interest
ids - Identified Signal
7s - Unknown Signal

After entering the data, click on “OK” to add the data to the Signal List.
Clicking on “X” causes the data to be ignored and exits the Add Panel.

Signal List Edit Function
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Prior to editing the Signal List, highlight the data to be edited by clicking
on that particular entry. Enter the “Edit” function by using the “Tools”
pull-down menu or by clicking on the “Edit” button. A panel similar to
the Add Panel appears on the screen. See Figure 3-7. The highlighted
data appears in the fields. Select the field by double-clicking and change
the data by using the keyboard. The edit function also supports multiple
entry editing. Use the click and drag function to select more then one
entry to edit. After a range of signals have been highlighted, press the
Control Key in conjunction with a mouse and click to de-select individual
signals from the range (if desired). After editing is complete, click on
“OK” to exit the Edit Panel.

Signal List Delete Function

Prior to deleting any signal list entry, highlight the entry being deleted by
clicking on that entry. Multiple entries are selected by using the click and
drag function identically to the Add Function. Enter the “Del” function by
using the “Tools” pull-down menu or the “Del” button. A pop-up window
appears on the screen requesting confirmation prior to deleting the
selected entries. See Figure 3-8. Click on “Yes” to delete the items, or
“No” to exit the delete function.

DELETE Signal List... CONFIRMATION:

Are you sure, you want to delete highlighted
data from Signal List?

Figure 3-8. Signal List Delete Function

Signal List Transfer Function

Enter the “Transfer” function by using the “Tools” pull-down menu or the
function button with the airplane on it. A pop-up window appears
allowing the user to customize the transfer of data. See Figure 3-9. The

.following outlines the options available:

° Receiver. Click on the down arrow to bring up a list of all receivers
configured in the system. Highlight the receiver that is to receive
the Signal List data.

° Operation. Click on the down arrow to bring up the two choices of

operation, Priority or Lockout. Highlighting Priority transfers the
Signal List data to the selected receiver for priority search
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Copy and Paste Function

operation. Highlighting Lockout transfers the Signal List data to the
selected receiver’s Lockout List.

° Option. Click on the down arrow to bring up the two options for the
selected Signal List data, Overwrite and Append. Overwrite
replaces the receiver priority or lockout list with the new data,
destroying the current listing. Append-adds the new data to the
priority list or lockout list of the selected receiver.

° Data. Click the down arrow to bring up the options for the data
menu. The menu offers the operator the choice of which entries on
the Signal List are to be transfered. Options include the enitre list,
signals of interest only, IDs only, ?'s only, or highlighted entries
only. Click on the appropriate choice.

' TRANSFER TO...

|

receiver

operation
option :
data

Figure 3-9. Signal List Transfer Function

The Copy and Paste functions allow the user to transfer data from one
Signal List to another. Highlight the data from the Signal List to be copied
and click on “Copy” under the “Tools” pull-down menu. Open the Signal
List file that is to receive the copied data. Use the Paste function to
complete the transfer. When activating the copy function, the copied data
is temporarily stored in the Windows™ Scratch Pad. This information can
be pasted into any Windows™ application.

Lockout List

While operating the receiver, the user may generate a list of lockout
frequencies. These lockout frequencies are primarily used with the
Spectral Search operation. Information in the lockout list is transferable to
a Signal List for signal list database building. To bring the active
receiver’s Lockout List window to the screen, click on “Lockout” and then
“Update” from the pull-down menu. Up to 100 lockout frequencies may
be entered on the Lockout List. The user may manipulate the data on the
Lockout List by using the four function buttons on the bottom of the
screen. See Figure 3-10.

3-16
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Chn Center BW Start Stop

Add| Edit|iIDel| %

Lockout channel# 001

Figure 3-10. Lockout List Window

Add Function

Enter the “Add” function by clicking on the ““Add” button. Two fields
appear on the screen, one for the center frequency and one for the
bandwidth. The channel number into which the lockout data is to be
added appears to the left of the "Center Lockout Frequency" field. Enter
the frequency in MHz by using the keyboard numeric keys. Press Enter to
validate the entry. Enter the bandwidth in MHz in the same manner. Click
“OK?” to enter the data on the list. See Figure 3-11. The Start and Stop
frequencies are automatically calculated and added to the data on the list.

OPERATION

3-17



CONTROL SOFTWARE OPERATION MANUAL

Center: BW:

#003

Lockout channel# 003

Figure 3-11. Lockout List Add Function
Edit Function

Prior to entering the edit function, highlight the lockout channel to be
edited. Enter the “Edit” function by clicking on the “Edit” button. The

_ edit function screen appears with the selected data in the two fields. See
Figure 3-11. Edit the data. Click “OK” to enter the data on the list. If
entering the edit function without highlighting a particular lockout
channel, the function operates identically to the Add function.

Delete Function

Prior to entering the Delete function, highlight the lockout channel or
channels to be deleted. Enter the function by clicking on the “Del” button.
A Confirmation Window appears requesting the operator confirm the
delete request. Click on the “Yes” or “No” button as appropriate. -
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Mnemonic Operation

Saving Receiver Operation

Transfer Function

The Transfer function moves the highlighted lockout channels to the
receiver’s Signal List. Highlight the channels prior to clicking the
“Transfer” button. After clicking the button, a Confirmation Window
appears on the screen requesting the operator confirm the transfer request.
Click “Yes” or “No” as appropriate.

The operator has the option of using the remote mnemonic commands
instead of the receiver control panel for operating the receiver. Click on
“Operation”, then “Mnemonic” to activate this option. A blank screen
appears on the screen, replacing the receiver control panel. Refer to the
specific receiver technical manual for commands available.

To save the current receiver's operation and parameters, click on “Flle
then choose either the “Save” or “SaveAs” function.

3.2.4 OPERATING IN SPECTRAL MODE

The Spectral Search mode allows the receiver to sweep from a start
frequency, labeled “FRA”, to a stop frequency, labeled “FRB”. The mode
also allows the operator to set an increment frequency, labeled “INC”, for
the sweep.” The Spectral mode is capable of setting up ten separate sweep
sectors per receiver. Two additional menu items are available in this mode
of operation that were not available in the Manual mode. One is the “Pan”
menu and the other is the “Report” -menu. The other menu items are
identical to the Manual mode of operation. See Figure 3-12. An RF Pan
display is available in this operating mode.
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WJ-RCS, RECEIVER CONTROL SOFTWARE
ile Config List Help

= RECEIVER CONTROL PANEL
le Operation Pan Report Lockout SigMon Window
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Tuned frequency selection

Figure 3-12. Spectral Operation Window

To enter Spectral operations, click on “Operation”, then “Spectral” from
the pull-down menu.

Creating a Sweep Sector

Spectral Search operation permits and excutes up to ten independently
programmed sweep sectors. See Figure 3-13 and 3-14. To add a sweep
sector, use the "Stop" control button to stop the search operation. Click on
the "Add" button to open another sweep sector. The operator can then
change the new sector to the desired values. After completing the set-up
of the sweep values, click on "Start Search” button to activate the search.
During the Spectral Search operation, RF Pan displays of each sweep
sector is available on screen. Use the "Pan" menu from the menu bar to
mainpulate and tailor the RF presentation for optimum viewing. There are
two groups of control buttons located directly above the RF Pan display
that play a major role in the spectral search operation. These buttons, from
left to right respectively, perform the following functions:

° Stop control button: stops receiver from sweeping. Permits
permanent change to the receiver parameters.

e Pause control button: pauses the receiver from sweeping. Permits
temporary change to the receiver parameters. Starting the sweep

3-20
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discards the changes and the receiver reverts to the previous

settings.
° Start Search control button: starts the receiver sweep operation.
° Single Sequence Search control button: starts a single sweep of the

receiver, ignoring all COR thresholds.

° Add control button: adds a sector to the receiver sweep operanons
when the sweep is stopped.

° Delete control button: deletes the selected sector from receiver
sweep operations when the sweep is stopped.

START
START SINGLE
STOP PAUSE SEARCH SEQUENCE

WJ-RCS, RECEIVER CONTROL SOFTWARE

WWW‘WWWMWW

| Bz 0020.0000 | [inci=|0000.0100 | [FFF5]0030.0000 |

Tuned frequency selection

Figure 3-13. Spectral Mode Sweep Control Buttons
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RECEIVER CONTROL PANEL
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96-0463

. Figure 3-14. Spectral Add and Delete Sector Buttons

Entering the Spectral
Search Frequencies

Enter the start frequency of the sweep by one of two methods. Click on
the “FRA” frequency readout to highlight the field. Enter the frequency
via the keyboard and press the Enter key. Leading or trailing zeros do not
need to be entered. Another method is to click on the “FRA” button. This
automatically enters the current tuned frequency of the receiver into the
“FRA” field.

Enter the “FRB” stop frequency in the same manner, either by highlighting
the “FRB” readout field or using the current tuned frequency of the
receiver. :

Enter the sweep increment frequency by highlighting the “INC” field. Use
the keyboard and Enter key to input the frequency.

Starting the Sweep

To start the sweep, click on the Start Search or the Single Sequence Search
button. See Figure 3-13. The single Sequence Search button enables a
single sweep of the sector while ignoring the receiver’s COR value. The
Start Search button starts the receiver’s normal sweeping action.
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Reporting the Signals

Creating New Sweep Sectors

In the Spectral Search operation, the operator has flexibility in how to tell
the receiver report and acquire signals. Click on “Report” in the menu bar
to select the options available from a pull-down menu. The following
options are available: :

° All Signals. The receiver stops on all signals that exceed the COR
threshold value.

° New Signals. The receiver stops only on those signals, exceeding
the COR threshold value, that were not active on the previous
sweep.

° Skip Adjacent. The receiver only stops on the first signal in a close

sequence of signals.

To create additional sweep sectors, stop the sweeping operation by
clicking on the Stop Search control button. See Figure 3-13. The current
sweeping action stops and two control buttons appear above the Pan
Display. See Figure 3-14.

Click on the “Add” button. An additional sector appears on the Pan
Display. Insert the start, stop, and increment frequencies. Click on each
area and insert the frequencies by either using the keyboard and Enter key,
or use the Receiver Control frequency readout and the “FRA” and “FRB”
buttons. Click on the “More” button of the Receiver Control Panel. Set
receiver parameters for this particular sweep sector. Refer to
paragraph 3.2.3 for operating receiver controls. :

_Add additional sectors in the same manner. Each click on the “Add”

button produces and additional sector on the Pan Display. Ten sectors are
available per receiver. After creating the sectors, start the receiver
sweeping action by clicking on the Start Search button (see Figure 3-13).
Figure 3-15 depicts a receiver configured with three sweep sectors.
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RECEIVER CONTROL PANEL
Operation Pan Report Lockout SigMon Window

R.01, VHF/UHF RCVR #1
STOP SPECTRAL SEARCH

EEEEEL iDel}

CEGERESER
24 .998

E2

Stop SEARCH operation and allow PERMANENT change to the receiver's parameters

960463

Figure 3-15. Spectral Operation With Three Sweep Sectors
Deleting Sectors

To delete sectors, stop the receiver sweep by clicking on the Stop Search
button (see Figure 3-13). Place the cursor within the sector being deleted
and click the mouse. Click on the “Del” button above the Pan Display.
See Figure 3-14.

Using the Pan Display

The Pan Display provides several options for the operator. Clicking on.
"Pan" in the menu bar, then on “Visible”, provides the operator with an
on-screen presentation of the sweep sectors and their start and stop
frequencies. See Figure 3-16. The check marked displays appear on the
screen. To stop a sector from being displayed, click on that sector in the
pull-down menu display.
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Figure 3-16. Pan Display with Visible Sector Parameters

The other option provides the operator with various sweep.display options.
Click on “Pan” and “Display” to see the available options from a pull-
down menu. The following describes the various sweep options.

Creating a Signal List

Real. Provides a real-time display of the signal environment.

Peak. Keeps all signal peaks on the display whether the signal is
active or not.

Cumulative. Each sweep overwrites the previous sweep.

Decay. Provides two choices of decay rate when a signal is no
longer active. Clicking on “Decay” provides a pop-up window with
a “Fast” or “Slow” decay rate choice.

Pen. The pen size controls the thickness of the sweep line. Clicking
on “Pen” provides a choice of five different pen sizes in a pop-up
window. Click on the pen size desired.

During Spectral operations, the operator has the option of adding a signal
to a Signal List. This data can be used during Priority Search operations,
to update or create a Lockout List, or provide data for building missions
for Mission Collection applications.
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To add a particular signal to the Signal List, move the cursor over the
sector and signal desired. As the cursor moves over a sector, sector
number, frequency, and signal level appear in the on-line help window
across the bottom of the screen. Double-click on the selected signal. This
action suspends the sweep and automatically adds the signal onto the
Signal List. A dashed vertical line appears on the Pan Display over the
chosen signal. Refer to Figure 3-17.

Config List Help ~‘
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Figure 3-17. Spectral Operat'ions Signal List

An alternate method of adding a signal to the Signal List uses the Add
Signal control button above the frequency readout on the Receiver Control
Panel. When the sweep stops on a signal that exceeds the COR threshold,
the receiver frequency readout displays the frequency. Click on the Add
Signal button to enter the data to the Signal List. This method does not
suspend the sweep operation.
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Creating and Using the Lockout List

During Spectral operations, the user may create and use a Lockout List.
There are two methods of creating a Lockout List. The operator may use
the Lockout button on the individual Receiver Control Panel, or transfer
frequencies from the Signal List to the Lockout List. To activate the
Lockout List, click on “Lockout” on the menu bar and make sure that there
is no check mark next to the "Ignore” menu item. When there is a check
mark next to the "Ignore” menu item, the lockout function is discarded
from the operation. '

The Lockout button adds the frequency in the receiver control panel
readout to the Lockout List. The following two methods provide a way to
add lockout data.

° Suspend the sweep by clicking on the desired signal. A dashed
' vertical line appears and the frequency readout on the receiver
control panel displays the selected frequency. Click on the Lockout
Control button to add the data. Restart the sweep by clicking the

Start Search button above the Pan Display (see Figure 3-13).

° When the sweep stops on a signal due to the signal exceeding the
COR threshold, the frequency appears in the receiver frequency
readout panel. Click the Lockout Button to transfer the data. This
method does not stop the Spectral sweep operation.

The Signal List provides an alternate way of setting lockout frequencies.
Data from the Signal List is transferable to the Lockout List via the
“Transfer” button on the Signal List. Refer to paragraph 3.2.3 for
explicit instructions on the use of this option.

Saving Spectral Operations

The receiver settings and sweep sector parameters for the Spectral
operation of each receiver can be saved to a file for future use. The
Lockout List and Signal List for each receiver is also saved. Click “File”
on the menu bar and then “SaveAs”. Provide a distinct name for each file
that is saved.
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3.2.5 OPERATING IN PRIORITY MODE

The Priority Search mode provides an automatic search of up to 100
channels of discrete frequencies. The search frequencies may be obtained
from a previously saved Priority file, downloaded from a Signal List, or
entered by using the Add Priority Channel control button. The receiver
and menu control functions are identical to those in Spectral operations.
No new functions have been added. Refer to Figure 3-18 for the Priority
operations screen. To enter the Priority mode, click “Operation”, then
“Priority” from the menu bar.

WJ-RCS, RECEIVER CONTROL SOFTWARE

“File Config List Help

] B () RO DA ;Y

File Operation Pan Report Lockout SigMon Window
: - R.01, VHF{UHF RCVR #1
SPECTRAL SEARCH

-097 dbm *

FREQ |i=h

0110.0000

s et e e e Bt e OB S S

Revr's ID: WJ-8607-

Il

Figure 3-18. Priority Operations Window
Creating Priority Channels
To create a Priority channel from the receiver control panel, stop the

receiver search mode by clicking the Stop Search button above the Pan
Display. See Figure 3-19.
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STOP PRIORITY SEARCH

Figure 3-19. Pan Display Control Buttons

After clicking the Stop button, two additional buttons appear above the
Pan Display, the “Add” and “Delete” buttons. These buttons add or delete
a sector while in Priority operations. See Figure 3-20.

STOP PRIORITY SEARCH

Figure 3-20. Priority Operations Add/Delete Channel Buttons

To create a Priority channel, click the “Add” button. The new channel
appears at the right end of the Pan Display. Click on the new channel and
change the channel parameters to the described set-up.

To create Priority channels from a Signal List, click “List”, then “Signal” -
from the pull-down menu on the WJ-RCS Receiver Control Software main
menu bar. Perform the following to transfer the selected signals:

° Highlight the signals to be transferrgd from the Signal List

° Click on the “Transfer” button (airplane) or click *“Tools” then
“Transfer” from the pull-down menu in the Signal List.

° Complete the pop-up menu selections (refer to paragraph 3.2.3).

e Click “OK” to transfer the data to the selected receiver.

To create Priority channels from a saved Signal List. click “List”, then
“Signal” from the pull-down menu. Select “File” then “Open” from the

menu bar of the Signal List window. Open the appropriate file. Transfer
the selected frequencies to the receiver as described above.

Creating a Signal List

To create or add to a Signal List in Priority operations, use one of the
following methods.

° Click on the Add Signal button above the receiver control frequency
readout when the selected channel is active. The channel is active
when the display in that channel turns red.

OPERATION
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Creating a Lockout List

Saving Priority Operations

° Click on the desired channel and stop the search operation. Then
click on the Add Signal button above the receiver control frequency
readout. Then restart the search.

° or, Double-click on the selected channel display.

To create or add to a Lockout List in Priority operations, use one of the
following methods.

° Click on the Lockout button above the receiver control frequency
readout when the selected channel is active. The channel is active
when the display turns red.

° Click on the desired channel and stop the search operations. Then
click the Lockout button above the receiver control frequency
readout. Then restart the search.

° Transfer selected frequencies from the receiver Signal List to the
Lockout List.

Lockout has no affect on the Priority Search operation. To temporarily
ignore a priority search channel, use "Idle" control button on the receiver
control panel to activate channel idling mode. This excludes the channel
from the search.

To save the current Priority operations settings, click on *“File” and then
“SaveAs”. Choose a distinctive name for the file for ease of recall at a
later time.

3.2.6 Using the Signal Monitors

The WIJ-RCS software permits the use of up to two WJ-9168 Signal
Monitors. These monitors provide a pan display that allows fine tuning of

" the receiver on a signal of interest. Ensure correct configuration of the

signal monitors with the receiver type being used. Refer to the WJ-9168
Signal Monitor manual for pertinent data and installation procedures.
Ensure that the Configuration System Hardware screen has been updated
with the proper information (see paragraph 3.2.1). If the configuration is
correct, the Receiver Control Panel enables “SigMon” on the menu bar.
See Figure 3-21.

3-30

OPERATION



CONTROL SOFTWARE OPERATION MANUAL -

WJ-RCS, RECEIVER CONTROL SOFTWARE
Help

File Config List

= RECEIVER CONTROL PANEL
File Operation Pan Report Lockout SigMon Window

R.01, VHFJUHF RCVR #1
SPECTRAL SEARCH

:'&«:

| 0000.0300 | |[(ERE] 0030.0000 |

Sector# 01, Freq = 0020.5352 MHz, Level = 001 dB , { F1 = 0020.0000 - F2 = 0030.0000 / Inc = =7

96-0470

Figure 3-21. Receiver Control Panel with Signal Monitor Available

To turn the Signal Monitor on, click “SigMon”, then “On” from the pull-
down menu. The dashed vertical line in the Signal Monitor pan display
represents the center of the tuned frequency. See Figure 3-22.
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WJ-RCS. RECEIVER CONTROL SOFTWARE
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Figure 3-22. Signal Monitor Pan Display -

To change the Signal Monitor pan display presentation, click on
“SigMon”, then “Sweep”. This provides a pop-up window allowing the
operator to change the display parameters for the best picture. See
Figure 3-23.
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Figure 3-23. Signal Monitor Sweep Display Window

To change the Signal Monitor display line, click on “SigMon”, then
“Display”. A pop-up window appears that allows a choice of the type of
display. The following describes the various options.

° Real. Provides a real-time display of the signal environment.

o Peak. Keeps all signal peaks on the display whether the signal is
_ active or not.

e Cumulative. Each sweep overwrites the previous sweep.

° Decay. Provides two choices of decay rate when a signal is no
longer active. Clicking on “Decay” provides a pop-up window with
a “Fast” or “Slow” decay rate choice.

o Pen. The pen size controls the thickness of the sweep line. Clicking
on “Pen” provides a choice of five different pen sizes in a pop-up
window. Click on the pen size desired.
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3.2.7 USING MNEMONICS

The Mnemonics mode allows the user to send a direct ASCII command to
the receiver.

To enter the Mnemonics mode, click “Operation”, then “Mnemonics”
from the pull-down menu. A blank screen appears in place of the receiver

control panel.

To return to any other mode of operation, Click “Operation”, then either

- “Manual”, “Spectral”, or “Priority’.

3.3 AUDIO PLAYBACK APPLICATION

The Audio Playback program permits audio signals (or clips) stored on the
hard disk during an audio collection mission to be retrieved and played
back via the controlling computer’s multimedia sound card. Detailed
signal information such as frequency, start and stop times, and signal
strength is provided for each stored audio signal.

Selecting the Audio Play icon within the WJ-RC Program Window opens
the Audio Playback window shown in Figure 3-24. This window is used
to open, close, and delete audio files ((EVA) stored on the disk during an
audio collection mission. Four tool box items, located below the main
menu, provide instant access to the items available from the File pull-down
menu. These tool box items are from left to right, Open File, Close File,
Delete File, and Exit.

;. SPAN Audio Playback

Figure 3-24. Audio Playback Window

3.3.1 PERFORMING AUDIO PLAYBACK FUNCTIONS

To play back audio events stored on the disk, the corresponding audio file
must first be opened. Opening an audio file accesses the Segment
Selection window depicted in Figure 3-25. Once a segment is selected, an
individual audio clip or multiple audio clips may be selected for playback
via the controlling computer's sound card. Additionally, audio clips of
interest can be flagged for future reference.
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3.3.2 SELECTING AN AUDIO SEGMENT

The Segment Selection window shown in Figure 3-25 identifies the
number of mission segments contained in the selected audio event file. A
new mission segment is created each time the audio collection mission--a
Spectral Acquisition or Priority Acquisition- is stopped and started via the
Mission Execution Application.

gment Selection

95-571

Figure 3-25. Segment Selection Window

Referring to Figure 3-25, the "# of Segment(s)" field of the Segment
Selection window identifies the number segments contained in the selected
audio event file. The "Segment" field indicates the segment selected for
audio playback. If more than one segment is contained in the opened audio
file, a scroll bar is presented below the "Segment” field that allows the
selection of a segment for playback. All displayed information on the
Segment Selection window is updated as new segments are selected. Also
identified in the Segment Selection window is the number of audio files
stored, their start/stop times, and dates for the selected segment.

Once the segment number is selected for playback, press the OK button to
access the Audio Clips Summary Window depicted in Figure 3-26. To
exit the Segment Selection window and to return to the Audio Playback
window, select Cancel.

Selecting Audio Clips

For Playback

Selecting the OK button on the Segment Selection window (Figure 3-25)
opens the Audio Clips Summary window shown in Figure 3-26. This
window plots a graphical representation identifying the frequency and time
of audio signals (or audio clips) received during the selected audio
collection segment. It also allows the user to obtain detailed information
regarding any audio clip within the frequency versus time display, and
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permits playback of received audio clips via the controlling PC's sound
card.

ASPT_COLL\COLLDATA\TESTAUD.EVA = -

Audio Clips Summary Picture, <Segme|
(@ Singio Clp . iTime

95-572

Figure 3-26. Audio Clips Summary Window

Points are plotted on the display for all audio signals (or clips) stored
during the selected mission segment. Placing the playback marking cursor
on a plotted point provides detailed information on that audio clip at the
bottom of the Audio Clip Summary window. Information provided
includes the memory channel number from which the audio signal was
acquired, the channel's tuned frequency, the received signal strength, and
the start/stop dates and times of the audio clip. Moving the mouse within
the display area updates information displayed above the Audio Clip
Summary window. Moving the mouse vertically updates the Chnl# field
identifying the audio mission file channel number's location on the display.
Moving the mouse horizontally updates time and date information
(T: nn/nn/nn nn:nn:nn). When the mouse cursor is placed directly on a
plotted audio clip, the channel's frequency and signal strength information
are also provided.

To select a single audio clip for playback, select the "Single Clip" item
located just above the time/date field. Then place the mouse cursor at the
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desired audio clip and press the left mouse button. This highlights the
selected audio clip and channel number. Detailed information concerning
the tuned frequency, signal strength, and the start and stop dates/times for
the selected audio clip are provided below the display area.

To select audio clips for playback between designated start and stop times,
select the "Time 1-2" item located just above the upper date/time field. To
select the start time, place the mouse cursor at the desired start time and
press the left mouse button. To enter the stop time, move the mouse cursor
to desired stop time and press the right mouse button. Once play is started,
all audio clips between the designated start and stop times are played.

To select all audio clips for playback for a selected channel number, select
the "Channel#" item located just above the upper date/time field. Move the
mouse cursor vertically to the desired channel number and press the left
mouse button. Once play is started, all audio clips for the selected channel
number are played.

Once the type of playback is selected (i.e., Single Clip, Time 1-2, or
Channel #), selecting the Play button with the mouse starts the audio
playback. i

Starting, Stopping, and
Tagging Audio Clips

Once playback starts via the Audio Clips Summary window (refer to
Figure 3-26) the Play_Audio Clip window opens as shown in
Figure 3-27. This window provides information on the audio clip
currently playing. This window also provides such details as the memory
channel number, tuned frequency, signal level, start/stop times, and the
.wav file name assigned to that particular audio clip.
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Figure 3-27. Play_Audio Clip Window

There are five playback control buttons on the Play_Audio Clip window
just above the "Chnl#" field. The control buttons, from left to right, are to:

1= Play the Prévious audio clip
2. Play the Next audio clip

3. Play a Paused audio clip

4. Pause audio playback

5. Stop audio playback.

There are three additional control buttons; Copy_Wav, ClipBoard, and
Info, just below the Play_Audio Clip title bar.

The Copy_Wav button permits copying the currently monitored audio
clip's ".wav" file to a designated disk drive and file name. This file can
then be stored or used by other multimedia devices as required.
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The ClipBoard button, when selected, places the information displayed for
the current audio clip into a "clipboard”. This information can then be
placed directly into other windows' application programs.

Selecting the INFO button opens the Comments window shown in
Figure 3-28. This window shows the operator comments that were
entered from the Mission Builder program. Comments can be edited using
the computer keyboard as desired. Closing this window updates and saves
the entered message.

Channel Ul] Coments

AR SIS

Figure 3-28. Comment Window

Initially, all audio clips are tagged as "Unidentified Audio Clip". This
identification field is located in the lower portion of the Play_Audio Clip
window. Once audio clips have been played, signals of interest can be
tagged by selecting the "Signal of Interest" item with the mouse. Identified
signals with no apparent interest can be tagged as an "Identified Audio
Clip".

3.4 FREQ LIST EDITOR APPLICATION

The Freq List Editor application is used to build a data base for ease of
system operations. Once parameters are entered, they may be used to
build collection mission files, create off-line receiver tasking, or be stored
for future use. Once parameters are on this list, they may be edited,
deleted, or stored.

Refer to Figure 2-1. To open the Freq List Editor, click on the icon in the
WI-RCS group menu. A Freq List Editor Panel appears on the screen (see
Figure 3-29). To add the current receiver parameters to this list, click on
the Add Signal button on the active receiver control panel. The
parameters are entered on the list and automatically highlighted.
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Figure 3-29. FREQ List Editor Window

The operator has several choices in using the Freq List Editor. Using
options under the “File” pull-down menu, the operator may open a new
file, open and existing Signal List file, import a file from other collection
missions, rename a file using SaveAs, or close the Signal List file.

The operator has the option of manipulating the data on the Frequency
List. Those functions are found on a pull-down menu, under “Tools”, or
accessed through the buttons on the bottom of the screen. The functions
include Add, Editing, Del. The following paragraphs outline their
operations.

3.4.1 FREQUENCY LIST ADD FUNCTION

Enter the “Add” function by using the “Tools” pull-down menu or by
clicking on the “Add” button. See Figure 3-30.
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Figure 3-30. Frequency List Panel, Add Function

The Add Panel allows the user to enter the frequency, IFBW, COR value,
detection mode, and type of signal. The bottom field is for entering
comments. The meanings for abbreviations for the types of signals are as
follows:

soi - Signal of Interest
ids - Identified Signal
?s - Unknown Signal

After entering the data, click on “OK” to add the data to the Signal List.
Clicking on “X” causes the data to be ignored and exits the Add Panel.

3.4.2 FREQUENCY LIST EDIT FUNCTION

Prior to editing the Signal List, highlight the data to be edited by clicking
on that particular entry. Enter the “Edit” function by using the *“Tools”
pull-down menu or by clicking on the “Edit” button. A panel similar to
the Add Panel appears on the screen. See Figure 3-30. The highlighted
data appears in the fields. Select the field by double-clicking and change
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the data by using the keyboard. The edit function also supports multiple
entry editing. Use the click and drag function to select more then one
entry to edit. After a range of signals have been highlighted, press the
Control Key in conjunction with a mouse and click to de-select individual
signals from the range (if desired). After editing is complete. click on
“OK” to exit the Edit Panel.

3.4.3 FREQUENCY LIST DELETE FUNCTION

Are you sure, you want to delete highlighted
data from Signal List? ’

Prior to deleting any signal list entry, highlight the entry being deleted by
clicking on that entry. Multiple entries are selected by using the click and
drag function identically to the Add Function. Enter the “Del” function by
using the “Tools” pull-down menu or the “Del” button. A pop-up window
appears on the screen requesting confirmation prior to deleting the
selected entries. See Figure 3-31. Click on “Yes” to delete the items, or
“No” to exit the delete function.

. DELETE Signal List... CONFIRMATION:

3.5 TRACE UTILITY

96-0457

Figure 3-31. Frequency List Delete Function

VAN

CAUTION

The Trace utility creates a log file of all communications
between the computer executing the WJ-RCS control
software and the controlled receiver. This log file grows
very rapidly during normal operations and will use up your
hard disk space if it is kept running.

VAN

CAUTION

Only use the Trace utility when directed to do so by
knowledgeable WJ personnel. If you feel that you have a
need to use this utility, contact the factory at 1-800-WdJ-
HELPS for further guidance.
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The Trace utility is a software debugging tool used in the development of the
WIJ-RCS software. It has limited end uses. Nevertheless. if vou have called
for assistance with an RCS problem, you may be asked to execute it by a W]
engineer. To do so, proceed according to the following steps:

1.

Shut down the WIJ-RCS application. Use Windows Explorer or File
Manager to locate and open the SPT_COLL directory on the drive where
the WI-RCS program is installed.

Create a new file in the SPT_COLL directory named “~traceon.~on".

Start the WJ-RCS application and perform the operation of interest. This
initiates the logging of communications.

Stop the WIJ-RCS application. To view the log of communications that
has occurred between the PC and the receiver, open the “trace.txt” file in
the SPT_COLL directory. This can be done with a text editor or a word
processor. '

NOTE: Subsequent runs of the Trace utility will overwrite the
“trace.txt” file. To retain a log file for later viewing, save it
under a new filename.

Delete the “~traceon.~on” file from the SPT_COLL directory to
disable this utility.

OPERATION

3-43



CONTROL SOFTWARE OPERATION MANUAL

THIS PAGE INTENTIONALLY LEFT BLANK

3-44 : OPERATION



WJ-RCS CONTROL SOFTWARE OPERATION MANUAL

A

Audio Clips Summary Window 3-39
Audio Playback 1-2
Audio Playback Program 3-36
Freq List Editor Application 3-41
" INFO Button 3-41
Playback 3-39
Segment Selection Window 3-37
Signal List 3-14
Spectral Search Mode 3-21
?s Unknown Signal 3-16, 3-43
Add Panel 3-16, 343 _
Add Signal Button 3-12, 3-31
AFC/AGC 3-13
Attenuation 3-13
Audio Clip 3-38
Audio Clip Summary Window 3-38
Audio Clips 3-36, 3-38
Audio Clips Summary Window 3-37
Audio Files 3-37
Audio Play Icon 3-36
Audio Playback Window 3-36, 3-37

B
Baud Rate 3-5
BFO 3-13
Bypass 3-14

C

Carrier Operated Relay (COR) 3-13
Change Receiver Frequency 3-12
Clipboard Button 3-41

Clips 3-36

Configuring The Receivers 34
Control Rx’s 1-2

Control Rx’s Application 3-1

Copy and Paste 3-18

Copy_Wav Button 3-40
Cumulative 3-27

INDEX

Decay 3-27

Delete Function 3-20
Delete Sectors 3-26
Detection Mode 3-13
Device Name 34
Digital Audio Files 1-2

Edit Function 3-20
Editing The Signal List 3-16, 343

F

FRA 3-24

FRB 3-24

Freq List Editor Panel 341

Frequency List Editor 1-3
G

General Description 1-1

H
Headphone Output 3-9

l
Ids 3-16, 343
IF Bandwidth 3-13
IF Oscillator 3-13
Interface Type 3-4

L

Lockout Button 3-12
Lockout List 3-29
Loss Dwell Timer 3-14

INDEX



WJ-RCS CONTROL SOFTWARE OPERATION MANUAL

M
Manual Mode 3-11
Mnemonics Mode 3-36
Multi-Drop 3-4

N

Noise Blanker Feature 3-23
Numeric Arguments 4-3
Numeric Keypad 3-8

o
Operating Modes 3-11

P
Pan Display 3-26
Peak 3-27
Pen 3-27

Play Button 3-39
Playback 1-2, 3-38

Playback Control Buttons 3-40

Pre-Dwell Timer 3-14
Priority Search Mode 3-29

R

Real 3-27

Receiver Control 3-11
Receiver Control Panel 3-10
Receiver Report 3-25

SAO 3-8

Saved Operations File 3-11
Segment Selection Window 3-37
Sigmon Number 3-6

Signal Dwell Timer 3-14

Signal List ASCI Data File 3-1
Signal Monitor Input Ports 3-6
Signal of Interest 3-41

Single Drop Mode 34

SOI 3-16, 341, 343

Start The Sweep 3-24

Switched Audio Output 3-8
System Configuration 3-3
System Hardware Configuration Panel 3-3

T

Trace Utility 3-42

. Transfer Function 3-20

U

Unidentified Audio Clip 3-41
Unknown Signal (?s) 3-16, 343

\"
Video Bandwidth 3-13
w
Wayv File 3-39
Wave Audio Packages 1-2
WIJ-RCS Receiver Control Software 3-1
XYZ

Y2K Compliance 1-3

INDEX



| .
% B
. |
e
I
r|\ﬂ|1.. o
N

T

i
|
il

i
5 ez e
i Iv_
—

i
SEUAE SRS NS T




	a0001
	b0001
	b0002
	b0003
	b0004
	b0005
	b0006
	b0007
	b0008
	b0009
	b0010
	b0011
	b0012
	b0013
	b0014
	b0015
	b0016
	b0017
	b0018
	b0019
	b0020
	b0021
	b0022
	b0023
	b0024
	b0025
	b0026
	b0027
	b0028
	b0029
	b0030
	b0031
	b0032
	b0033
	b0034
	b0035
	b0036
	b0037
	b0038
	b0039
	b0040
	b0041
	b0042
	b0043
	b0044
	b0045
	b0046
	b0047
	b0048
	b0049
	b0050
	b0051
	b0052
	b0053
	b0054
	b0055
	b0056
	b0057
	b0058
	b0059
	b0060
	b0061
	b0062
	b0063
	b0064
	b0065
	b0066
	b0067
	b0068
	c0001

